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Introduction 

About this Document 
The document describes features that are implemented in ABBYY FlexiCapture 11 Release 2 compared to ABBYY FlexiCapture 10. 

About the Product 

ABBYY FlexiCapture 11 is a new version of FlexiCapture created on base of ABBYY FlexiCapture 10 with new features and 

improvements.  

Upgrading from previous versions 
 
Detailed description of upgrade can be found in the System Administrator’s Guide.  

ABBYY FlexiCapture 11 Release 2 supports projects created in ABBYY FlexiCapture 10 and ABBYY FlexiLayout Studio 10.  

Key Features 

Part #: 1112/4, Build # 11.0.1.1121, OCR Technologies build number 13.0.12.96, Release date: June 2, 2014 

This version includes numerous improvements in field and rule setup, import, verification UI, export to SharePoint, 

administration and monitoring, scripting, FlexiLayout Studio and FormDesigner. 

New Features and Improvements  

1. Project Setup 

1.1. Field properties 

1.1.1. Default field value 

Text fields and text columns of tables may have default vales which will automatically substitute empty values on verification. 

The empty value will be substituted if the field is not filled after Document Definition matching or document assembly, and also 

in the case when the field region was deleted. If the field value was deleted by the operator, the field will not be populated with 

the default value. 

The default value can be specified in the Document Definition, filed properties, Data tab. 

1.1.2. Recognition of inverted text  

Now a field with inverted text (white text on a black background) can be recognized according to the corresponding setting on 

the Recognition tab of the Field properties dialog.  



 

1.1.3. Date normalization 

Settings for date normalization were added in the Date field properties. 

 

The date normalization is required when the date format in documents may differ, but the date format in the exported data 

must be the consistent. 

It is possible to include the day of the week and the time in the final date format. These parameters must be allowed in the Data 

type settings as well - otherwise a format error will occur during the processing. 



 

1.1.4. Amount and number normalization 

It is possible to specify normalization format for the Number and the Amount of money fields. The normalization is performed 

on the exported data.  

 

1.1.5. Field verification threshold 

This setting allows specifying a minimal percentage of highlighted characters with which the field will be sent to the field 

verification. Please note that this percentage depends on the highlighting characters settings. For example, if no characters are 

highlighted, the field will not be sent to the field verification even if it contains uncertainly recognized characters. 

 



 
 

This setting is useful in the case when only fields with many unconfident characters should be sent to field verification. For 

example, the recognition quality of printed fields is rather high, and it is not necessary to verify fields with one or two uncertain 

characters. But if a printed field has more than 50% uncertain characters, it may be matched incorrectly or a field value may be 

obscured – then a verifier should check it. 

1.2. Rules  

Several enhancements have been introduced to make the configuration of validation rules more convenient and user-friendly. 

Newly introduced features include the possibility to apply rules depending on a condition, rule grouping, and easier and more 

flexible rule search and filtering.  

1.2.1. Conditional launch  

Now rules can be launched on conditions. It is possible to define a condition in the Document Definition Properties, Rules tab 

when editing a rule or creating a new rule. 

 

1.2.2. Search and filtering 

A possibility to filter rules has been added. It is useful for projects with many rules. Rules can be filtered by name, reference field 

or launch condition. 



 

1.2.3. Rule chains 

The order of rules is regulated by the internal logic of the system. In some cases, it is necessary to establish a custom order of 

launching rules. To meet this need, rule chains were implemented. Within a chain, a strict order of rules is set up. 

To create a rule chain, open Document Definition Properties, Rules tab and click Chains… button. In the dialog box that opens, 

it is possible to create new chains, add rules to the chain and setup rule order using Move Up and Move Down buttons. Rules 

will be launched in the order specified in the chain. 

 

1.2.4. Advanced database look-up 

Database look-up settings have become more flexible. The following options have been implemented: 

 Selection of columns and setup of their display order in the advanced database look-up 

 Selection of columns for display to the user from different database tables 

 Selection of database fields to substitute  

 Generation of the list of possible field values from the database to be displayed while typing the value in the field 

 Work with views which can be created by the administrator in advance and used as a table 

To create an advanced look-up rule, open Document Definition Properties, Rules tab and create new rule with Database Check 

type. 



 

It is now possible to indicate a Source Type for the database:  

 Data Set means that the data will be taken from the internal database structure. Data Set must be previously defined in 

the Data Sets tab of Document Definition Properties. Data will be stored internally, can be updated periodically, and 

the access to the data is very quick.  

 External Database (Simple) – select this option to establish a direct connection to the database. Data will be taken from 

the external database, so anytime data is needed, there must be a connection with the external database storage. 

 External Database (Variable) – similar to the previous option, but the connection string is defined as a variable which 

can be reused in several document definitions.  

After selecting the source type, it is required to indicate the Data Set, the connection string or a variable name for the 

connection string, depending on the selected source type.  

Select the Don't check if all fields are empty option to skip the rule check if there are no values in the fields involved in the 

comparison. It will allow the document rule check to be completed faster. 

Map the fields in the Document Definition to the fields in the database table. The comparison can be Exact or Fuzzy. In the case 

when Don’t Search if field is empty value is set to true, the comparison will not be performed if the field is empty. 

The field will be filled with a value from the database if option Fill from database is selected. There are two possible options: 1) 
the field can be filled if the value found on the document differs from the value in the database, or 2) the field can be filled only 
when it is empty (i.e. was not found on the image). 
 
Enabled option Allow empty values in DB means the following:  

- if the field is empty in the database and absent in the document, it will be considered a match. 
- if the field is empty in the database, but not empty on the document, it will NOT be replaced by the empty value. 

The database lookup rule also allows adding two types of buttons on the form:  

 Database LookUp – opens a window on the verification station for searching a record in the database. 

 Save Data to Data Set – saves changes made by the verification operator to the internal Data Set.  

The buttons can be added and used if you use cached Data Set for the database and have created a rule with this Data Set as a 

source. 



 

1.2.5. Precision for amounts 

In the Check Sum rule, it is now possible to set precision. It helps to avoid alerts triggered by of rounding errors (for example, 

such errors can happen during tax calculation and small differences like 5-10 cents between calculated and printed amounts 

which are generally acceptable). If the precision is specified, the rule will not display an error for differences within a precision 

value. 

 

1.2.6. Hiding the rule name from the error message 

A setting that allows hiding the rule name from the error message has been added: Rule properties dialog, General tab -> Show 

rule name to a verifier option. Rule names are usually internal and may be confusing for verifiers, so it is enough to display the 

rule error message only. 



1.3. Enhancements to the data form  

The data form has been redesigned for better flexibility. Now the layout of fields in the Document Editor is displayed in the same 

way on rich and web verification stations. The main enhancements: 

 A table structure is now used to position elements on the form. This allows creating forms with flexible layouts. 
 Several elements can be grouped and moved around as a single element. 

 All form elements can be aligned vertically and horizontally (relative to the form table cells). 

 Descriptive text and field captions can be multi-line.  

 It is possible to choose columns of the table field which will be displayed on the verification station’s data form. 

 A summary of field values is shown for a collapsed group of fields. This helps the verification operator to understand if 
fields require verification without expanding the group. 

 Group instances are displayed as a table, so they take less space on the form. 

2. Import 

2.1. Registration parameters 

2.1.1. Import of registration parameters from external sources 

Possible values of the registration parameters can now be imported from a file or a database. To use this option, enable 

checkbox Use external source of values and enter a path to the file or a database connection string. 

 

2.2. Scanning Station enhancements 

2.2.1. Connection via a proxy server  

Now it is possible to define a proxy server in the Scanning Station settings. Use menu command Tools > Options…, FlexiCapture 

Server tab. 



 

2.2.2. .Net scripting support 

.Net scripting can be used on the Scanning Station.  

 

The work with external assemblies is also possible now. 

 

2.2.3. Discarding image modifications  

All changes made to the image automatically or manually, like cropping, rotation, color changes etc., can now be discarded using 

the context menu command Back to Source Image. 

Scripts also allow saving source images using parameter UseRawImage=true of IImageSavingOptions object. 



2.2.4. Image Window improvements  

A quick switch between the thumbnail view and the page view by means of a double-click on the page has been implemented. 

Additionally, it is possible to specify the quantity of thumbnails per screen. With these improvements, image view can be flexibly 

configured for an operator. 

2.3. Import from e-mail 

2.3.1. Import from POP3 servers with SSL or TLS encryption 

Import from POP3 e-mail servers with SSL or TLS encryption is supported. To setup an Import Profile with a POP3 server, select 

POP3 server as the image source, enter the server address and click Settings… to specify the user name and password. 

 

2.3.2. Saving sender, recipients, date, time and subject 

Information about the e-mail sender, recipients, date, time and subject is saved in batch registration parameters automatically. 

It can be exported together with the recognized data or used during the processing, if necessary. The list of the registration 

parameters: 

Fc_Predefined:EmailSubject 
Fc_Predefined:EmailSender 
Fc_Predefined:EmailAddressee 
Fc_Predefined:EmailDate 

 

 

2.3.3. Saving source e-mail as a batch attachment 

The source e-mail from which FlexiCapture has imported image attachments can now be attached to the batch. This option is 

available for POP3 import profile type only. 

This option is useful if you need to store the source e-mails together with extracted data. 



 

3. Processing 

3.1. Improved barcode recognition 

A thorough recognition mode for skewed 2D barcodes has been implemented. To enable it, add the following registry keys: 

For Processing Stations: 
[HKEY_CURRENT_USER\Software\ABBYY\FlexiCapture\11.0\DAForms] 
"UseDABarcodes"="true" 

For Scanning Station: 
[HKEY_CURRENT_USER\Software\ABBYY\ScanStationFC\3.0\DAForms] 
"UseDABarcodes"="true" 

To enable this mode in FlexiLayout Studio, enable option Barcodes: Thorough extraction mode in FlexiLayout properties 
(FlexiLayout/Classifier > Properties…, FlexiLayout tab).  

Note. This mode can provoke significant slowdown. It is recommended to enable it only when standard recognition mode for 2D 

barcodes does not provide satisfactory quality. 

3.2. Local and universal format of dates  

Dates that are generated automatically by the program are now displayed either in a local format (depending on the operating 

system locale) or in the universal format YYYY-MM-DD in order to make day and month position obvious in regions with 

different date formats. 

Dates in the License Manager, on rich and web stations are displayed in the local format.  The new UI language English (United 

States) has been added for the web stations. 

Dates in universal format are used in the internal metadata such as registrations parameters, batch names etc. These dates are 

stored as strings and should not be changed dynamically; therefore it is more convenient to make them independent of the 

locale settings. 

3.3. Environmental variables 

Environmental variables store parameters that are shared between different entities in ABBYY FlexiCapture. These variables can 

be accessed from settings or scripts. 



 

There are two types of environmental variables: 

 String – contains any text. It can be used in export settings to specify a path or a file name. The following tag should be used 
to indicate the variable in a file name: <Env:Environmental_variable_Name> 

 ADO Connection String – contains a database connection string. It can be used in the following conditions: 

 Export to a database 

 Database check rules 

 Format check against allowed values 

Variables of both types can be used in scripts: the IProject interface, IProperties -> EnviromentVariables property. 

4. Verification 

4.1. Field grouping 

Fields on the data form can be grouped together under the common name and with a displayed summary of values in order to 

facilitate verification. A group of field can be configured to automatically collapse or expand depending on a condition. The 

default state of the group can be changed in the Document Definition editor, Group properties, Format tab, combo-box Initially 

Collapsed. Available values are: No, Yes, If doesn’t have errors, If all fields are empty.  

Note. If option If doesn’t have errors is selected and errors were generated after the document had been opened on verification, 

the group will not be automatically expanded. 

4.2. Field snapshots on the data form 

Fields of Text, Barcode and Checkmark Group type can be supplemented with a snapshot (snippet of the original image) to 

facilitate visual review of data. To add a snapshot to the field, select this field on the data form in the Document Definition 

editor, right-click on it and select Insert Field Picture Box from the menu. Then move the snapshot in a desired position. 

 



4.3. Cache-based suggestions for field values  

This possibility is available for Document Definitions with FlexiLayouts only. 

When the operator starts typing a value in a blank field, FlexiCapture suggests possible values generated from the OCR cache of 

the page. The operator needs to simply select the correct value from the list to populate the field.  

 

4.4. Other improvements of the verification UI 

 Zoom in/zoom out on images was improved. Zooming is now done around the cursor and is available from the 

keyboard (Ctrl+Num+, Ctrl+Num-). 

 Framing of the field in focus is replaced by highlighting to increase the visibility of characters  

 An asterisk marks a mandatory field (instead of an unmatched field, as it was in the previous versions) 

 It is now possible to specify an order of fields in the document editor for tab, F4, and F8 buttons. To change the order, 

right-click on the form in the Document Definition editor and select Tab order… Change the order using Up and Down 

buttons. 

5. Export 

5.1. Export to formatted columns in SharePoint 

It is now possible to export fields of a particular type in formatted columns in SharePoint. The following column types are 

supported: 

 Date and time 

 Number 

 Currency 

 Boolean 

6. Administration and Monitoring 

6.1. E-mail alerts for Monitoring Operators and Administrators  

Users with the role of Administrator and Monitoring Operator can subscribe to e-mail alerts for important events. Subscribers 

will receive e-mail notifications when errors occur, requests for permissions are made, the term of their license ends soon, their 

license runs out of pages or the file storage runs out of free space. The notification about soon license expiration is sent when 

there is less than 10% pages remaining or less than 30 days left until the absolute expiration date. 

Users can subscribe to the notifications on the Administration and Monitoring Console, Service > Notifications settings.  

6.2. E-mail notifications for users 

In case of self-registration, users of ABBYY FlexiCapture now can receive notifications to the e-mail address specified during 

registration. Notifications are sent on the following events: registration confirmation by the Administrator or password reset 

with a temporary password issued.  

6.3. Display license state in the Administrator and Monitoring Console 

The current license expiry date and remaining pages are displayed on the main page of the Administrator and Monitoring 

Console.  

These license parameters are accessible only for the Administrator. The license parameters are only displayed when Processing 

Server is launched; otherwise message “Inaccessible data” is displayed.  



6.4. Automatic deletion of hanging sessions opened via API 

Station sessions opened via the API and hanging due to a station failure are deleted automatically and the license ticket is 

released. The default inactivity period after which a session is deleted is 240 minutes. It can be changed in the IIS settings on the 

Server level, the InactiveSessionTimeoutMinutes parameter. 

For rich stations, an attempt to restore the session is made after re-opening the station. If the attempt is successful, the same 

session and license ticket will be used. 

7. Scripts and customization 

7.1. New event handlers in Document Definition 

The following event handlers were added in the Document Definition Editor: 

 Before document parameter change – the same event previously was available on the batch type level 

 After document state changed – the same event previously was available on the batch type level 

 Field verification request – the same event previously was available on the batch type level 

 After document rules checked – a new event which occurs after checking all rules in a document. It can be useful in the 

following scenarios: 

o Generate a virtual table via the script using the data from document fields. 

o Create a rule that will modify values of several fields in one script after all other checks 

o Correct registration parameter values 

 

If the same event is specified on the document definition level and on the batch type level, the document definition event 

handler starts first. 

7.2. Information about the next processing stage for a document  

New property MarkedNextStage was added in the IDocumentItem object. It allows getting information about the next stage to 

which the document will be sent. It can be useful if some checks or actions must be done before sending the document to a 

particular stage. 

7.3. MaxPagesToMatch property of the IMatchingInfo object 

The MaxPagesToMatch property was added in the IMatchingInfo object. It can be used when it is necessary to match a flexible 

document section without the footer on a particular number of pages in the Before Matching script. 



7.4. Getting the batch creator name  

The IPrincipal property was added for the IBatch object. It returns the batch creator name via scripts. The property can be used 

to get the name of the scanning operator without using registration parameters. 

8. FormDesigner 

8.1. Checkmark group import in FlexiCapture 

A checkmark group is now imported in FlexiCapture as a checkmark group element. Previously it was imported as a set of 

separate checkmarks and it took additional time to create a group in FlexiCapture. 

8.2. Custom cell size for text fields with marking 

A possibility to specify custom cell size in the Entry field element has been implemented. Cell width may vary from 3 mm to 5.5 

mm, cell height – from 4 mm to 7.5 mm. These limitations exist because too small or too large text can be recognized 

incorrectly. 

 

In addition, the Extra Large (5x7mm) cell size common for American forms has been added.  

8.3. Black delimiters in the Entry field 

A possibility to add black delimiters defining the field structure in the Entry field element has been implemented. The field with 

delimiters is regarded as one field in FlexiCapture. Please note that delimiters are also recognized as they are a part of a field. 

This feature allows creating “formatted” entry fields, e.g. phone number with a code: (NNN)-NNN-NN-NN. 

 

A delimiter is a field tip that will be black on the form of any type. To add a black delimiter, it is necessary to type “&” character 

before the separation character. The expression for the phone number on a black and white form will look as follows: 

&(<space><space><space>&)<space><space><space>&-<space><space>&-<space><space> 

8.4. Preserving field marking on a printed PDF form 

A special mode has been added to preserve field marking in a printed PDF form.  To enable this mode, add the following key in 

the registry: 

HKEY_CURRENT_USER\Software\ABBYY\FormDesigner\11.0\Shell\Options\Export\ExportPDFWithComb 

This allows filling the form partly in the PDF file, then printing it out and filling the rest of fields on paper. After the form is 

scanned, the field markings will be consistent for recognition with a template in FlexiCapture.  

This mode has certain limitations and therefore is disabled by default: 

 Validation with regular expression does not work for text fields with marking 



 The built-in check that only numbers should be typed in the Numeric field does not work because the Text field type is 

used instead of Numeric. The field type is changed due to extra position delimiters that are added automatically in the 

Numeric field with marking in a PDF form.  

 It works only for single-line fields, and the text should be written from left to right.  

 If the field has a list of possible values, the marking is not preserved because PDF forms don’t support a field type that 

would combine both the marking and a list of values. 

8.5. Enhanced image quality in image-only PDF files 

The quality of the image in image-only PDF files has been improved.  Previously it was low, and exported PDF files could not be 

used for printing. 

9. FlexiLayout Studio 

9.1. Work with multiple batches in a project 

A FlexiLayout Studio project now can contain multiple batches. This enables the user to group together images of different types 

or images from different sources and work with them independently. However, the user can work with only one batch at a time. 

9.2. Changes to the Batch window 

- When the user opens an empty batch, a dialog box for adding pages is now displayed.  

- Commands are now available to fit column widths to the records inside the columns (Right-click, Fit Column Width, Fit All 

Columns Width). 

- Users can now select columns to display (Right-click, select needed columns). 

- The icons in the batch window have been supplied with tooltips. 

- Two new columns have been added: Match Quality (shows how well the FlexiLayout matches the page) and Training 

Layout State (shows the state of the training layout). 

- The shortcut menu of the Batch window now contains only those commands which can be used in the current operational 

mode. 

9.3. Modifying element properties in the Properties window 

The Properties window, placed by default in the left bottom corner, is not read-only anymore; users now can modify the 

properties of the active object in this window. 

9.4. User-defined hot keys 

Users can specify a keyboard shortcut for any menu item. This is done on the Shortcuts tab (Tools > Options > Shortcuts). 

9.5. New FlexiLayout training capabilities 

FlexiLayout training mode now enables the users to train the selected layout alternative. The set of fields is common to all 

alternatives, while anchors can be set up separately for each.  

The following user options have been introduced: 

- Ability to mark only fields and the program will find the anchors automatically; 
- Group fields; 
- Train the selected layout alternative while adjusting the FlexiLayout; 

FlexiLayout Studio now allows automatically generating an identifier for a selected layout alternative (an identifier is a group of 

elements of type Static Text which contain the keywords of the selected layout alternative). Identifiers help the program select 

the right layout alternative when matching FlexiLayout for a page. 

9.6. Classifier training capabilities 

If the classifier tree is initialized automatically, FlexiLayout Studio can immediately populate the newly created tree nodes with 

elements of type Static Text that contain the keywords for each node. The user can immediately start the training of the 

classifier on the automatically selected training set. 

Identifier elements for classes can now be created automatically based on the information the program collects about the 

availability of keywords for a given class on the pages in the training set (i.e. words that occur on multiple pages in the set). 



A Suggest Subfeatures command has been added to automate the division of page classes into subclasses. This command 

provides the user with a list of keywords that can be used to divide the class currently selected in the node into subclasses, and 

create the corresponding subclasses and child nodes. This approach can be used to “complete” an existing tree of solutions, or 

to build a tree from scratch, dividing nodes down to the desired level, starting from the root node. 

9.7. Logging  

The log window is now displayed for all operations in the FlexiLayout project or in the Classifier project. The log contains 

information about the progress of processes and detailed statistics for FlexiLayout and classifier matching. Log data can be saved 

to a text file. 

9.8. New element: LineOfElements 

A new Group element has been introduced: Line Of Elements (LineGroup). The purpose of the element is to find simple 

subelements of various types which are positioned on the same line. There may be any text in between the defined 

subelements, and there may be a slight vertical shift between subelements. 

9.9. User OCR dictionaries 

To improve OCR quality on poor-quality documents, users can now create their own dictionaries and use them in conjunction 

with built-in dictionaries. The words in user dictionaries may be given priority over the words in built-in dictionaries. 

Additionally, a dictionary may be created by specifying a regular expression. 

Custom dictionary can be created on the User Dictionaries tab of the FlexiLayout properties dialog box (FlexiLayout/Classifier > 

Properties). 

9.10. New program options 

New options are now available:  

- images may be recognized as soon as they are added to a batch; (adding images to the batch, Image Preprocessing 
Settings… button, Pre-recognize images on adding) 

- when adding images from FlexiLayout Studio projects, the information about the pages’ classes or layout alternatives 
may be retained. (Adding images to the batch, Import Pages from FLS project…, Page Import Settings… button) 

- Users can now enable or disable the display of hypotheses when applying FlexiLayouts (Tools > Options… > Other tab > 
Show hypothesis on match (show only on test element if unchecked)).  

- FlexiLayouts can now be applied automatically when going to the next or previous page or document. (The button 

  on the toolbar enables this option.) 

9.11. New languages in Date element 

New languages have been added to search months spelled in words in Date element. The list of added languages: 
 

- Dutch 
- Portuguese 
- Greek 
- Danish 
- Polish 
- Finnish 
- Swedish 

 

- Norwegian 
- Turkish 
- Hungarian 
- Czech 
- Lithuanian 
- Latvian 
- Estonian 

 

9.12. FlexiLayout Language 

The following new functions have been added to FlexiLayout language: 

- To read strings from XML files using XPath queries:  
o String ReadSingleStringFromXML( String filename, String xPathQuery ) – this function allows to read a string 

from xml-file “filename”. 
o StringArray ReadFromXML( String filename, String xPathQuery ) – allows to read an array of strings from xml-

file “filename”.  
- To convert strings to numbers while allowing for possible pre-recognition errors: 

o Logic IsIntFuzzy( String inputString, Logic isStrictMode = false ) – allows to verify if the string inputString can be 
safely converted to Integer taking into consideration possible recognition errors;  

o Int StrToIntFuzzy( String, Logic isStrictMode = false ) – returns a result of conversion of the string inputString to 
Integer taking into consideration possible recognition errors; 
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o Logic IsRealFuzzy( String, String separators = defaultDecimalSeparators, Logic isStrictMode = false ) – allows to 
verify if the string inputString can be safely converted to Real taking into consideration possible recognition 
errors; 

o Real StrToRealFuzzy( String, String separators = defaultDecimalSeparators, Logic isStrictMode = false ) - returns 
a result of conversion of the string inputString to Real taking into consideration possible recognition errors. 

- To put numerical parameters into a string: 

o String SubstParam(String param0) or 
o String SubstParam(String param0, String param1) or 
o String SubstParam(String param0, String param1, String param2) or 
o String SubstParam(String param0, String param1, String param2, String param3) or 
o String SubstParam(String param0, String param1, String param2, String param3, String param4) – returns a 

text of a string changing all %n characters by corresponding parameters. n is a not negative whole number. 
Number of %n in the string must be equal to the number of parameters. Original text of the string is not 
modified. 

o String SubstParam(StringArray params) – the same as above but parameters are in array. 
- To mark unreliably matched blocks with IsSuspicious label. Blocks labeled as suspicious will be always forwarded to 

FlexiCapture for further verification. IsSuspicious is a variable of a Logic type used in the section Region Expression of block 
description. 

- AddLanguage function has been added to the search parameters of elements of type Date:  
o Void AddLanguage( String ) – this function adds a language for the name of the month to the languages 

already specified in the element.  
- To detect Character String elements, users can now specify leading and trailing characters which should be ignored by the 

program when generating a hypothesis  

Void TrimSymbols( String ) – specifies characters which should be ignored at the beginning and at the end of a hypothesis. 

10. Languages support 

10.1. UI and documentation localization 

The UI and the documentation are available in English and Russian only.  

The translation of the documentation and resources will be made in September according to the table below. 

 French German Polish Spanish 

FlexiCapture         

Resources + + + + 

Readme + + + + 

Standalone Administrator Help + + - - 

Standalone Operator Help + + - - 

Distributed Administrator Help + + - - 

Scanning Station Help + + - - 

Distributed Data Verifier Help + + - - 

Distributed Verifier Help + + - - 

Distributed Developers Help 

(API) 
- - - - 

Administrator's Guide + + - - 

Web Stations         

Resources + + + + 

Help (Authentication)  + + + + 

Help (Scanning Station) + + - + 

Help (Data Verification) + + + + 

Help (Verification) + + + - 

Help (WEB Capture) + + + - 

Help (Monitoring) + + - - 

FormDesigner         

Resources - - - - 

Help FD - - - - 

A Guide to Creating Machine-

Readable Forms + + - - 

License manager         
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Resources + + + + 

FlexiLayout Studio         

Resources - - - - 

Help FCS - - - - 

Tutorials - - - - 

Installer         

FC Stations + + + + 

Remote Scanning Station  + + + + 

Remote Data Verification Station + + + + 

Remote Verification Station + + + + 

Standalone + + + + 

Samples         

Banking + + - - 

Questionnaire + + - - 

Invoices - + - - 

Letters&Contracts - - - - 

Prices - - - - 

Single Entry Point - - - - 

10.2. Document Definition custom localization 

A possibility to localize project text messages has been implemented.  

It is possible to specify field names, rule names and error messages in a local language in order to make it 

independent from the FlexiCapture user interface language. With localized field names and rule error messages, 

operators can verify the recognized data easier. 

Localization can be done via a text file: Document Definition -> Localization -> Export text to localize…, Import 

localized text… 
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Known Issues 
№ Description Solution or workaround 

 Installation/Uninstallation  

1 Uninstallation fails sometimes due to error message: 
C:\Windows\System32\inetsrv\config\applicationHost.config 
file is not accessible. The error occurs only on computers 
were FlexiCapture 10 was installed. 
The following record appears in the uninstallation log: 
Error 1722.There is a problem with this Windows Installer 
package. A program run as part of the setup did not finish as 
expected. Contact your support personnel or package vendor. 
Action Launch_lnstairrool.exe_install, location: C:\Program 
Files (x86)\ABBYY FlexiCapture 10 Servers\lnstairTool.exe, 
command: /install 

To uninstall the program successfully, follow the 
instruction below. 
1. Open 
C:\Windows\System32\inetsrv\config\applicationH
ost.config file in the Notepad 
2. Delete <AbbyyFlexiCaptureAuthentication 
enabled="true" /> line and save the file. 
3. Reboot the computer 
4. Uninstall ABBYY FlexiCapture. 

 Project Setup  

2 A document definition cannot be disabled if it has a new 
unpublished version. In this case, the new version is disabled 
but the previous version is active and can be used for 
processing. 

It is necessary to publish the new version or 
discard changes before disabling a document 
definition. 

3 Fields cannot be added in a logical group in the Document 
section during the creation of a Document Definition. This 
means that it is not possible to group them on the Data form 
for more convenient verification. 

 

4 Project -> Compact command has been added in the 
Administration Station and Project Setup Station main 
menus, but it has limitations. It is available only on 
Administration station of the Standalone installation, and on 
the Project Setup station for local projects. 
The command deletes old document definition versions 
starting from the last but one and deletes files successively. If 
some files were deleted manually earlier, automatic deletion 
will not work. 

Do not use this command. 

 System Administration  

5 A batch type name in a server project is updated from the 
local project by deleting the old batch type and creating a 
new batch type with old settings and new name. The type of 
batches created with the old batch type name is reset to 
Default. 

Change batch type name only after processing all 
current batches. 

6 Several projects with the same name can be uploaded to a 
FlexiCapture server and therefore cannot be distinguished on 
the Administration and Monitoring console. 

A unique name should be specified for each 
project. 

7 Error message ..\Protection1001\0\FineObjects\Inc\Object.h, 
268 appears after deactivating one license and activating 
another license. 

After clicking OK in the error dialog, it is possible to 
select the activated license. 

 Verification  

8 Error message "Cannot use normalization format with current 
parsing parameters" always occurs for the field of type 
"Time" when normalization with any parameters is used. 
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9 It is possible to get tasks from the Verification and Exceptions 
queues on the Data Verification station with the following 
settings:  

 Data Verification stage is disabled in the workflow 
settings.  

 An operator opens the station with the Verifier or 
the Senior Verifier roles. 

Use Verification station in case Data Verification 
stage is disabled. 

10 Error message.\Frame\DocumentFrame.cpp, 420 appears 
when a postponed task has been opened for editing from the 
Batches view. The error occurs when saving changes. 

Open the postponed task from the Queue view 
under the operator who postponed it. 

11 Rule error messages are displayed in the Processing station 
UI language on Web Verification Station. 

 

 Export  

12 If export is performed in a CSV file with the following settings: 
The semicolon is used as delimiter, Target: Export all 
documents to one file, then a delimiter is changed to Tab 
after exporting the second document. 

 

 Workflow  

13 Tasks can be sent to a stage with enabled option "Linked to 
previous" in the following case: 
1) The "Allow operator to send tasks to this stage" is enabled 
in the stage properties of the Exit Routes -> Next stage dialog 
box. 
2) The task is opened by an operator. 
The stage is not available when sending tasks to stages via 
the Batches view. 

 

 


